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Abstract 
Town centres have been analysed by researchers according to the specific parameters 

of their studies such as concentration cores of economic activity or on the basis of their 

social and demographic attributes, diversity of land uses, etc. However, it is the synthesis 

of all centre’s characteristics that most completely define it. Moreover, in Greece, there 

is no sufficient statistical information available concerning town centres and it is 

necessary to create such data in order to improve their monitoring, control and planning. 

In order to apply this information, the boundary of town centre has to be set. This paper 

envisages in the definition of a town centre, the creation of a “Town Centricity Model” 

and the development and implementation of a consistent methodology resulting to its 

delimitation. After survey, analysis and evaluation of characteristics serving as centrality 

estimators, the most critical are deployed and the methodology is implemented. The 

latter concerns the design and creation of a geodatabase in a Geographic Information 

System (GIS) with features and attributes set to the spatial reference unit of a building 

block. The use of both vector and raster spatial analyses are addressed, the most 

representative qualitative methods are surveyed and weighting factors with the use of 

Delphi method are assigned. The pilot study of the aforementioned methodology is 

implemented in a case study area located in the municipality of Athens in Greece, 

resulting to the delimitation of its centre. The results are presented and ongoing future 

research is further discussed. 
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1. INTRODUCTION 

Town centers have been studied and approached by many different scientific disciplines 

basically in the light of specific characteristics of the centre (Bartzokas-Tsiompras et al., 2021) 

concluding to concepts and definitions such as Central Business District (CBD), Inner city, Old 
or Historic Town etc. However, town centers encompass various roles or activities and it is in 

any case the composition of all these parameters that can most completely define their 

complicated meaning. Therefore, they are amongst others, places of concentration of 

economic and work activity, the focal points of social and cultural life as well as entertainment 
and historical locations.  

Many issues relating to the definition of the town centre need to be further explored. Any 

researcher who has studied the town centre has tried to demarcate it based on his/her sole 
definition. The spatial delimitation of a town centre at a more complex level has not been fully 

developed despite of the multiple benefits that it can offer which are related to its integrated 

design and sustainable development. In Greece particularly, there is no consistent available 
statistical information concerning its town centers; thus, there is a need for reliable statistics 

which can help in controlling and monitoring their vitality and viability. In order to compile and 

produce these statistics, the geographically referenced town centre boundaries should be 

determined with the best possible precision by collecting and analyzing all necessary spatial 
data.  

The main objective of this paper is to define a method for the delimitation of the geographic 

extent of a town centre in order to create its spatial borderline and use it as the basemap for 
further statistical processing. A “Town Centricity Model" is going to be developed that will 

introduce and implement a consistent methodology of setting boundaries around 

concentrations of town centre’s estimators that can finally be used to define central statistical 

areas. 
In order to achieve this, it is necessary to identify and then quantify the key factors that 

characterize town centers using georeferenced data sources. After research, analysis and 

evaluation of the possible centrality indicators, the most significant ones are chosen and a 
consistent methodology for the spatial modelling of the urban centre is applied. 

The latter concerns the design and creation of a geodatabase in a Geographic Information 

System (GIS) using spatial analysis methods of vector and raster data. Data Management and 
pre-analysis procedures, data analysis and the application of weighting factors using the 

interactive structured Delphi method, are presented along with their results. A resulting central 

boundary is produced, which can be used with corresponding statistical information by policy 

makers and planners to make consistent and sustainable decisions taking into consideration 
all critical characteristics of the town centre. Protection, monitoring, forecasting and 

management of the ongoing changes of the centre can also be supported more effectively.  

The case study which analyzes all the stages of the aforementioned methodology is 
implemented in the centre of the municipality of Athens in Greece. The conclusions of the 

present work, along with its advantages and disadvantages are analyzed and presented and 

ongoing future research is further discussed.  

2. DEFINITION AND BASIC CHARACTERISTICS OF TOWN CENTRE  

In order to approach more completely a town and to further be able to delimitate its centre, we 

initially have to define it by identifying its most critical parameters and characteristics. The first 
step is to examine the concept of the town itself. In the ancient years a town could be identified 

easily since it referred to a living space with a church, a square, a market and a town hall. 

However, nowadays it seems more difficult to recognize a town since urban sprawl has 
changed the previous pattern and we encounter such kind of structures in almost every 

settlement.  

On the other hand, towns are considered to be the highest forms of social organization. If 

we consider their road network complexity and transportation systems or their building and 
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urban laws we can understand some of the reasons why. It is almost impossible to develop a 

perfect town or city but we can make a lot of improvements with better management of the 
problems occurring inside their boundaries and especially inside their centers. 

As far as concerning the word "centre" we believe it can be best described by the word 

"core". Etymologically, the "core" is defined as the central body portion of a different density 
of the rest of the mass. Respectively, we can assume that a town centre is the central part of 

an urban area with a different density of uses, operations, benefits, activities, infrastructures 

and human presence from the rest of the town. Consequently, referring to the word "centre", 
we include all concepts that have been studied for more than 50 years such as the Central 

Business District, the Inner city, the Historical, Cultural and Retail Centre; considering that all 

these definitions together constitute a representative approach of the town centre. Therefore, 

the town centre is amongst others, the core of all major economic, social and recreation 
activities, and the place where significant remnants of the past such as historical buildings 

exist. It is undoubtedly the centre around which a town or a city develops and spreads through 

time. 
All the above mentioned characteristics of a town centre form the basic centrality estimators 

that can be grouped into four different scientific fields namely urban, economic, demographic 

and traffic (Missouri’s, I.A., 2014). In each of the above sectors there are different town 
centre’s key characteristics that most completely define its meaning. The most critical ones 

that we are to analyze in this paper are as following:  

- The diversity of land uses is considered to be a primary urban feature of a town’s 

centrality. Town centers are locations that incorporate many different uses and functions (such 
as commercial, recreational, institutional, transport and business); whistle on the other hand, 

away from a central area, operations and activities tend to be more homogeneous and 

aggregated (i.e. residential uses). 
- The employment activities associated with the town centre are the main reason why 

people visit town centers. The element of employment is a good indicator of the types of 

economic activities that occur in town centers. Hence, by mapping town centre employment it 

should be possible to locate the various functions associated with the town centre. Conversely, 
by mapping non town centre employment the areas which are highly unlikely to be located in 

the town centre could be identified. Therefore, retail, commerce, business, offices, public 

administration, restaurants, bars, culture and services are positive indicators while industries, 
construction sites and warehouses are negative indicators concerning the economic 

employment profile of a town centre. The mapping of both (using non applicable town centre 

employment activities as negative indicators) results in a surface in which the maximum values 
are shown in areas of town centre activity and the minimum in areas outside of its centre. 

- Public transportation accessibility. The town centre should be accessible to the 

population it serves by the use of public transportation. By defining areas accessible to public 

with collection of relevant data such as public transport routes, a general impression of the 
extent of the central area is given from the perspective of its accessible surface. 

- The permanent population of residents and especially the lack of this characteristic is 

also a key indicator of town centers. The development of retail, commercial, business and 
recreational activities in a town centre has inevitably reduced the residential land use, resulting 

in relatively low population densities in the central areas of a city. 

3. METHODOLOGY: TOOLS & TECHNIQUES 

The methodology for determining a town centre essentially refers to the combination of the 

above mentioned basic indicators of centrality where each one depicts a feature related to a 

specific activity and function that characterize the centre. These values are used to produce 
distinctive surfaces showing the levels of activities taking place in the town centre.  

Initially, the collection, analysis and evaluation of the geospatial data of the estimators that 

are used to determine the area of the centre are performed. Next, a case study area based 

on a grid is defined to cover the full extent of the urban surface where each of the 
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characteristics is modeled and analyzed using a Geographic Information System (GIS) and a 

relative value is attributed to each pixel of the resulting grid. One of the advantages of 
converting all features from vector to raster is the ability to merge them using the overlay 

analysis technique, which is the most established technique in geospatial semantics. In other 

words, the features are represented as raster data and, since the dimensions of these grids 
are the same, it is possible to perform accurate aggregate calculations of the values of each 

feature. These values are used to produce a final surface which will represent the rating of all 

the estimators throughout the study area. 
Spatial analysis with use of a Geographic Information System (GIS) is the prevalent method 

used in order to locate the urban centre of the study area and to produce the surface of "town 

centricity". An acceptable boundary of the composite surface can then be generated that will 

delimitate the extent of the town centre. The area to be determined by the latter boundary can 
form the central statistical area of the town.  

Before the overlay analysis of the surfaces of each centrality estimator, the assignment of 

particular weighting factors for each indicator takes place by using the Delphi structured 
communication method. 

The main data sources can be the municipal services, statistical authorities, private sector 

as well as on-site surveys. These datasets require a lot of processing in order to be imported 
in the same GIS, and they need to be updated and evaluated so as to yield satisfactory results.  

Brief references of the methods, tools and techniques that were used in the context of this 

paper are quoted in the following subsections. 

3.1. Geographic Information System (GIS) 

A geographic information system (GIS) is a computer-based system tool capable of 

assembling, storing, manipulating, and mapping geographically referenced data. GIS 

technology integrates common database operations such as query and statistical analysis 
along with the unique visualization and spatial analysis techniques. The basic components of 

a GIS comprises of the following (Koutsopoulos K., 2002): 

- Hardware, which refers to the equipment needed to support the activities for geospatial 
analysis ranging from data collection to data analysis.  

- Software, which refers to the GIS application package that is essential for creating, editing 

and analyzing spatial and tabular data.  
- Data, which is the core of the system. A geodatabase is a database that is referenced to 

locations on the earth. Geodatabases are grouped into two different primary types of data i.e. 

vector and raster. Vector data is spatial data represented as points, lines and 

polygons.  Raster data is cell-based data such as aerial imagery a digital elevation 
models.  There is also the attribute data which is generally defined as additional information 

in tabular format about each spatial feature. 

- People, that refer to well-trained GIS professionals with strong knowledge in spatial 
analysis.  

- Methods, which refer to a successful GIS operating according to a business plan and rules 

for each organization. 

3.2. Spatial Analysis 

Spatial analysis is a set of methods applying statistical analysis and other analytical 

techniques to data that have a geographical reference. Such analysis typically employs a GIS 
software capable of processing such data and applying analytical methods to spatial datasets. 

The analysis of spatial patterns and spatial relationships of geographic data is the core 

function of each GIS (Agourogiannis et al., 2021; Fernandez & Escampa, 2017). The 
examination of spatial models and analytical methods of spatial relationships can be applied 

by different analytical approaches, each one adapted differently in the framework of a GIS.  
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Reality can be transformed into a geographic database in many ways, of which the most 

important are the vector and the raster formats. Both forms of coding have advantages and 
disadvantages, and the use of one or the other form depends on the purpose of the 

application. As far as concerning Raster Data Analysis, especially in cases where data from a 

series of geographically overlapping entities are to be used, database management and 
calculation of new attribute values are easier when data refer to a grid. Raster data analysis is 

differentiated into individual functions such as: 

 -  Local or Point Functions which refer to each pixel separately, 
-   Focal Functions which calculate each pixel, based on data from a particular region, 

 -  Zone Functions which provide procedures for each set of pixel having the same values, 

-   Generalized Functions also referenced in a box but based on data for the entire grid 

source cells. 

3.3. The Delphi method  

The Delphi Method is a structured communication technique or method which relies on the 
opinions of members of a group of experts about a subject and presents a final more 

sophisticated result. It is based on the principal that decisions from a structured group of 

experts are more accurate that those from unstructured non experts groups. It consists of a 

series of repeated questions, usually in the form of questionnaires, to members of a group 
whose opinion is considered to be significant. After the questions of the first round, the 

questions of each subsequent cycle to each member are accompanied by information about 

the answers of the other members of the group which are presented anonymously. Each 
member of the group is then encouraged to reconsider his point of view and possibly modify 

the initial answer in the light of the replies of the other members. The method provides equal 

opportunities for expressions of opinion to all participants, in order to avoid common work 

group errors. After two or three cycles, the group's result is averaged. The method is usually 
carried out asynchronously through letters or e-mail, and can also be implemented via a 

teleconferencing system. Interaction between members is directed by a coordinator who 

isolates anything that is not relevant to the subject of the group. This way the usual team 
problems are overcome. Delphi method follows basically ten stages as following: 

i) Formation of a team responsible for supervising procedures on a specific issue. 

ii) Selection of one or more groups to participate in the exercise. Typically, members of 
these subgroups are experts of this subject. 

iii) Creation of a questionnaire for the first phase of the Delphi method. 

iv) Check of the questionnaire on the relevance with the study. 

v) Transmission of the first questionnaires to the members of the groups. 
vi) Analysis of the first phase responses. 

vii) Preparation of second-stage questionnaires (and possible testing). 

viii) Transmission of the second phase questionnaires to the members of the groups. 
ix) Analysis of the second phase responses. 

x) Preparation of a report by the analysis team for the presentation of conclusions from the 

exercise. 
According to research (Rowe,1991), there is no need for a large number of experts. The 

minimum number of those involved depends on the structure of the problem. Experiments 

have shown that small groups like those of four members can perform quite well.  The experts' 

opinions are summarized statistically rather than in the majority. 
 

 

4. CASE STUDY OF ATHENS GREECE 

The methodology for the identification and delimitation of the town centre, using the above 

tools and techniques, was implemented in the case study area that is regarded to be a broader 
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central part of the municipality of Athens. The reason for this selection was that Athens is the 

capital of Greece and a lot of studies have been conducted resulting to the existence of various 
datasets. Moreover, the area is familiar to most people and we expected to find all the selected 

characteristics to be analyzed. The centrality estimators which were found to be more critical 

and analyzed at the building block level were as following:  
- the diversity of land uses,  

- the permanent population of residents and intrinsically the lack of it,  

- the employment activities  
- the accessibility to public transportation, which was estimated by its density. 

 

The data used were as following: 

- four vector feature layers of linear topology regarding roads, buses, metro, tram 
and railway. 

- two polygon feature layers of the boundaries of building blocks. 

- a polygon feature layer with attribute data of the land uses and employment  
- a thematic layer with population data of 2011.  

The spatial data source for the first three layers was Geodata S.A. while the last dataset’s 

source was the Hellenic Statistical Authority. The GIS software used was ArcGIS/ESRI. 
Briefly, the methods used for data management and spatial analysis concerned both vector 

and raster data. More specifically, before the raster data analysis, the vector data was 

analyzed by defining and organizing the correct attributes and then by clipping all data to the 

boundary of the study area. Afterwards, vector data was converted into raster and focal 
functions were used for the production of the surfaces of public transportation accessibility in 

order to calculate its density and apply it to each pixel. For the indicator of the diversity of land 

uses, zonal functions were used to generate the corresponding grid. Before the production of 
the final raster dataset, weighting factors were estimated with the use of Delphi method and 

were assigned to all grid surfaces of the four characteristics. The final step regarded the 

overlay of the above raster datasets, their analyses and the production of the grid showing the 

'town centricity'. The methodological steps followed in this case study are further discussed 
and analyzed in the next subsections. 

4.1. DATA MANAGEMENT & ANALYSIS 

At the first stage, the initial vector data of each centrality estimator was processed in order to 

have a suitable and homogeneous format of all data in the same spatial extent and resolution 

in the national coordinate system of Greece. A geodatabase was created with all relevant 

features in ARCGIS and all vector data were initially clipped to the borderline of study area 
and they were then converted to raster format. By converting all vector data into raster, we 

were able to integrate them into one surface using the overlay analysis technique. The 

conversion process of each estimator was implemented using ArcGIS/ArcToolbox -> 
Conversion Tools -> To Raster -> Feature to Raster. The pixel size was decided to be set at 

5m which was found to be an adequate resolution for the scale and scope of the present work. 

The grid surface produced regarding the characteristic indicator of diversity of land uses 
depicted how many different land uses exist within each building block. Therefore each pixel 

of the grid corresponded to a value of the factor of the diversity of land uses, while cells that 

did not fall inside the building blocks were assigned zero values. This surface was created 

using the Zonal Functions (in particular the Variety function) provided by ArcGIS/ArcToolbox-
> Spatial Analyst Tools-> Zonal-> Zonal Statistics. The raster data of land uses was used as 

a Zone Matrix, and the raster data of building blocks was used as a Price Matrix.   

The resulting grid concerning the characteristic indicator of accessibility to public transport 
was a surface where each pixel was given a value of the public transport's density. In this 

case, the Focal Functions (focal statistics) and in particular the function that calculates the 

maximum value in each cell located in the centre of a 30x30m size dimensions was 

applied. This function was chosen because it was considered that in a neighborhood of pixels, 

http://eurogeojournal.eu/
https://www.eurogeography.eu/


 

Marakakis et al., 2022 

 

European Journal of Geography - ISSN 1792-1341  50 

the maximum value overlaps the other density values. The function was applied to each of the 

public transport density grids separately by 
using ArcToolbox > Spatial Analyst Tools > Neighborhood > Focal Statistics. Since these 

grids have a 5 m pixel size, the area of 150 x 150 m in reality is a reasonable value regarding 

the area for accessibility to public transport. All the above grids concerning densities of 
different means of public transportation were overlaid and a single raster was produced.   

The data regarding the permanent population along with the total number of jobs in the 

study area were included in the attribute table of the polygon theme of building blocks; thus 
each one of these factors was converted with ArcToolbox from vector to raster by using the 

corresponding attribute field. 

 

Table 1: Correlation coefficients of centrality estimators 

Correlation of characteristic indicators Correlation 

coefficient 

Employment activities - Lack of Permanent Population 0.07 

Employment activities - Accessibility to public transportation 0.23 

Employment activities - Land Uses Diversity 0.03 

Lack of Permanent Population - Accessibility to public 

transportation 
0.12 

Lack of Permanent Population - Land Uses Diversity 0.06 

Land Uses Diversity - Accessibility to public transportation  0.02 

 
As we can see from the above table, the values of the above correlation coefficients are 

very small; thus all four surfaces of centrality estimators can participate with appropriate 

weighting assignment, in the creation of the final surface of town centricity. 
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4.3. WEIGHTING PROCESS USING DELPHI METHOD 

Each characteristic indicator does not have the same impact to the definition of town centricity; 

thus weighting factors were assigned to all four estimators, before overlaid and merged as 

one. Delphi method was used for the estimation of the weighting factors. These values were 
assigned and calculated in ArcGIS/ArcMap -> Spatial Analyst -> Raster Calculator. Firstly a 

questionnaire was created where the scope and indicators to be scored was thoroughly 

described. This was handed to four experts, with great experience in both GIS and urban 

planning fields, and the process was completed in two rounds. 
 

Table 2: Results of the first round of the Delphi Method 

Factors / Experts A B C D Average 

Diversity of Land Uses 35% 40% 35% 50% 40.00% 

Accessibility to public 
transportation 

20% 25% 10% 30% 21.25% 

Lack of Permanent 
Population 

25% 15% 25% 10% 18.75% 

Employment activities 20% 20% 30% 10% 20.00% 

 

The corresponding respondents were then informed of the average of the results and asked 
to review the weights they had given and to complete the questionnaire again. 

 

Table 3: Results of the second round of the Delphi Method 

Factors / Experts 
Factors / 
Respondents 

A B C D Average 

Diversity of Land 
Uses 

Diversity Uses Land 30% 45% 30% 45% 37.50% 

Accessibility to 
public 
transportation 

Accessibility in MMM 20% 25% 10% 30% 21.25% 

Lack of 
Permanent 
Population 

Lack of Permanent 
Population 

30% 10% 20% 10% 17.50% 

Employment 
activities 

Seats Working 20% 20% 40% 15% 23.75% 

 

For all surfaces of the factors, except the one showing the lack of permanent population, 

the formula applied to the weighting procedure was essentially formed as following: 

[final grid] = (surface/max surface) 
310 weighting factor 

where [final grid]: the final raster’s value 
[surface]: the raster’s value to which we will assign the weighting factor 

[max surface]: the maximum value of the surface. 

(The number 10 3 was used in order to avoid very small values). 
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Especially as far as concerning the assignment of weighting factor for the surface of the 

permanent population, the previous formula was used differently in order to represent the lack 
of the permanent population. : 

[final grid] = weighting factor 10 
3
- (surface/max surface) 

310 weighting factor 
 

The following summary table shows for each surface its maximum and minimum value and 

its corresponding weighting factor. 

Table 4: Surface value ranges and weighting factors 

Surface Range values Weighting factor 

Diversity of Land Uses min = 1 & max = 8 37.50% 

Accessibility to public transportation min = 0 & max = 122 21.25% 

Lack of Permanent Population min = 0 & max = 1258 17.50% 

Employment activities min = 0 & max = 3799 23.75% 

 
The following maps show the raster surfaces (grids) that were produced after the 

assignment of the corresponding weighting factors. 

 

Map 1: Diversity of land uses 
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Map 2: Employment activities  

 
 

Map 3: Accessibility to public transportation 
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Map 4: Lack of Permanent Population 

 
 

Map 5. Grid of ‘Town Centricity’ 
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4.4. TOWN CENTRICITY MODEL 

Each grid at this final stage intrinsically presents the value of each of the four centrality 

estimators in each pixel, after the assignment of its corresponding weighting factor. Since all 

grid surfaces had the same pixel dimensions (5mx5m), they were all combined and merged 
in a single surface where each pixel’s value refers to the aggregate value of all the above 

characteristic indicators using the Overlay Analysis Technique in 

ArcGIS/ArcMap > Spatial Analyst > Raster Calculator. 

In order to finally illustrate the composite raster surface of ‘Town Centricity’ of the study 
area, the grid values were classified into five (5) categories/classes using the Statistical 

Classification method. The classification process was applied in the ArcMap environment of 

ArcGIS using the method of Natural Breaks. Creating classes with this method is based on 
existing data value groups. ArcMap creates classes by grouping similar values and at the 

same time maximizing the differences between them. In this way the boundaries of the classes 

are defined where there are large gaps between data values. The composite grid of ‘Town 
Centricity’ is shown in the following map. 

4.5. Results  

Observing the Map 5. it can be easily seen that the ‘dark’ areas depict the more 'centered' part 
of the study area of Athens. In these ‘darker’ building blocks the sum of the total grid values 

of all four centrality estimators is higher than in others. The result of this work is very much in 

accordance to current real situation. The area depicted as the central part is found around 
Omonia square up until a part of the Syntagma square. More activities are presented in 

building blocks located between the Stadiou, Panepistimiou and Akadimias streets, in the 

triangle of Piraeus - Ermou and Athinas streets, and also between Karaiskakis and Omonia 

square. By examining the area that appears as the centre in the above map, we confirmed 
with on-site visits that there is indeed a great diversity of land uses. There are also a lot of 

local markets, offices and businesses, public services and retail and entertainment places 

located in the area. In addition, the permanent resident population is limited since many people 
work in this area. We also are aware that this area offers many means of access to public 

transport since a lot of buses, metro and tram routes cover this area of the municipality.   

Finally, a boundary line was set as threshold for the higher values of the composite ‘Town 

Centricity’ surface, which essentially delimited the centre to a certain extent (see Map 
6). However, it should be mentioned that the specific area of the centre of Athens is difficult to 

be delimited by a strict and single boundary. That is because first of all the original extent of 

the case study area is limited and secondly because there is a sense of gradual movement 
from the centre rather than a limit beyond which it is considered to be outside of it.  

However, the procedure of setting a boundary line would definitely be more evident if we 

use this methodology in a much greater study area where we could spatially define and locate 
even more than one centers. 

 

 
 

 
 

 
 

 
 

 
 

Map 6. Boundary of ‘Town Centricity’ (Red) 
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5. CONCLUSIONS AND FUTURE RESEARCH 

Conclusively, it is evident that the results of the methodology which was developed in the 

context of this paper are in agreement to what we consider to be the most centered part of the 
case study area of Athens. On site visits in the area further strengthened this perception. 

Therefore, reality largely confirmed the results of the methodology applied and the objective 

of this work, concerning the spatial definition and delimitation of a town centre, has been 

achieved to a great extent.   
The aforementioned methodology could also be implemented with the use of additional 

centrality estimators. High development density values, high property prices and tourist 

attraction places are some other characteristics which can be utilized and checked in addition 
to the present work’s results. However, the four characteristic indicators chosen and analyzed 

namely, the diversity of land uses, the lack of permanent population of residents, the 

employment activities and the accessibility to public transportation, are the most 

representative ones as far as concerning the estimation of the centrality of a town. 
Moreover, the use of other methods such as fuzzy logic can also be applied and its results 

can be checked and compared to the ones of this paper. The difference is that fuzzy logic is 

basically a form of many-valued logic in which the true values of variables may be any real 
number between 0 and 1, in contradictory to the Boolean logic, used in this paper, where the 

true values of variables may only be the integer values of 0 or 1. Machine learning can also 

be utilized for future research. The process of machine learning begins with observations or 
data, such as examples, direct experience, or instruction, in order to investigate data patterns 

and manage to take better decisions in the future based on the examples that we provide the 

system. In particular, Geographical Random Forest (GRF) algorithm is interesting to be 

researched because it refers to a spatial analysis method that uses a version of machine 
learning algorithm that can be used for evaluating, forecasting and controlling the methodology 

of town centricity and its results. It allows the investigation of the existence of spatial instability 

in the relationship between a dependent and a set of independent variables. This technique 
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embraces the idea of geographically weighted regression and was designed to be a bridge 

between machine learning and geographical models. 
The resulting boundaries of the methodology applied in this paper could be utilized, with 

further research, in order to successfully produce Central Statistical Areas for all towns / cities 

of Greece. The statistics produced for the town centers can help recognizing problems that 
the central urban area faces, and can be used for protection and even for the prediction and 

forecasting of the changes that can occur in the future. However, besides the generation of 

nationally consistent statistical areas of town centers, the methodology could have other 
applications such as validation of national datasets, local data collection, and ultimately 

creation of services in a decision urban support tool. 

It is possible that there will be cities or towns without conventional and established centers. 

Especially nowadays, the revolution of digital technology allows this to happen quite easily. 
Nevertheless, we hope that social and communication human needs will preclude the creation 

of decentralized towns. 
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